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User Guide for the Plotting Software for the  
Los Alamos National Laboratory  
Nuclear Weapons Analysis Tools  

Version 2.0 
Timothy Cleland 

Abstract 
The Los Alamos National Laboratory Plotting Software for the Nuclear Weapons 
Analysis Tools is a Java™ application based upon the open source library JFreeChart. 
The software provides a capability for plotting data on graphs with a rich variety of 
display options while allowing the viewer interaction via graph manipulation and scaling 
to best view the data. The graph types include XY plots, Date XY plots, Bar plots and 
Histogram plots.  
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User Guide for the Plotting Software for the  
Los Alamos National Laboratory  
Nuclear Weapons Analysis Tools  

Version 2.0 

Introduction 
The Los Alamos National Laboratory (LANL) Plotting Software is a plotting package 
that is used by the Nuclear Weapons Analysis Tools. Users of the Nuclear Weapons 
Analysis Tools may be shown data plotted in graphs using this software, and may wish to 
display their own data in similar graphs. This user guide is provided to assist the user of 
these tools in using the graphing capability provided. 

The LANL Plotting software is written entirely in the Java™ language and uses the open 
source library JFreeChart as its basis. It can be executed on any computer with a suitable 
Java runtime environment (JRE). The application has been tested on Windows 7 and 10 
computers running Java™ 1.8. It has been tested on Mac OS X computers with Java 1.8. 
While it has not been tested on Linux computers, it will probably run on those machines 
also.  

The rest of this user guide explains how to use the LANL Plotting Software. 

Software Distribution DVD 
The LANL Plotting Software is a supporting application in the Los Alamos National 
Laboratory (LANL) Nuclear Weapon Analysis Tools. The software may be ordered from 
the Defense Threat Reduction Information Analysis Center (DTRIAC) at Kirtland AFB. 
Please contact Janet Ortiz at 505-846-9420 or JANET.ORTIZ_CONTRACTOR 
@abq.dtra.mil. If Janet is not available, then call 505-853-1789, or send an email to: 
dtriac@abq.dtra.mil. Ask to be put on distribution for the LANL Nuclear Weapon 
Analysis Tools. The thirteen applications comprising the analysis tools will be shipped on 
a DVD. Figure 1 shows the directory structure of the distribution DVD. 
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Figure 1: Distribution DVD Contents 

Copyrights and Distribution 
The copyrights.txt file has copyright information on software written by non-LANL 
authors that is included with the open source libraries, or that is included directly in the 
source code. The Distribution.txt file has the limited distribution caveats for the software. 
The software is Official Use Only, because it is Export Controlled as critical technology. 
Note: The plotting software by itself, when separated from the rest of the LANL Nuclear 
Weapon Analysis Tools, is releasable to the public with unlimited distribution. The 
plotting software is in the library/plotting folder for each operating system. 

Overview of the Software 
The LANL Plotting Software has four main types of graphs, 1) the XY Plot, 2) the Bar 
Plot, 3) the Histogram Plot, and 4) the Date XY plot. The user interfaces for each of these 
graph frames consists of an array of menu commands. These will be explained and 
illustrated for each graph type. 

The XY Plot 
The XY Plot consists of 2-dimensional data plotted on the X and Y axes (see Figure 1). 
The default display behavior is for the X axis (or domain axis) to be on the horizontal and 
for the Y axis (range axis) to be the vertical. However, as we will show shortly, the axes 
can be reversed so that the range can be the vertical axis and the domain the horizontal 
axis.  



13 
 

 

Figure 2: This is the XY Plot tool with some example data plotted. 

File Menu 

The File menu handles input and output operations for the graph. It may be accessed by 
using the menu bar or shortcut key combination Alt+f (Windows), or Control+Option+f 
(Macintosh). Selection of a save or import menu item brings up a standard file chooser 
window for your operating system that will allow the user to navigate through the file 
system and select or define a file for the operation. In the exporting or saving case, if the 
file already exists, a warning message asking to confirm that the file should be 
overwritten is displayed.  

Export to PNG...  

When this menu item is selected, a file save dialog will open allowing the user to select a 
directory and enter a file name to save the plot in the Portable Network Graphics (PNG) 
format with the “.png” file extension.  

Export to JPG...  

When this menu item is selected, a file save dialog will open allowing the user to select a 
directory and enter a file name to save the chart in the JPEG (Joint Photographic Experts 
Group) format with the “.jpg” file extension.  
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Print...  

This option selection will display the page set up window (See Figure 3.). This window 
presents options for the style and look of the chart page being printed as well as selection 
of the printer for the job. After the OK button is clicked in Fig. 3, the standard dialog will 
show to select the print options. The plot will be scaled to print on a full page of paper.  

 

Figure 3: Page Setup dialog obtained when using the Print… option. 

Save as Text  

The Save as Text menu item has two submenus for saving the entire chart, or saving just 
one line of the chart to a text file.  

Save Chart...  

Selection of this submenu opens a standard file save dialog for your operating system that 
allows the user to navigate through the file system and to choose an existing file or to 
create a new file to save the chart to. For better readability, the file will contain 
information of the main features and leaves out certain details such as tick size, 
background color, and some others. If these attributes are important, the user may use the 
Export Chart... submenu of the Export menu.  
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Chart Text File Format: Below is an example file showing the format of the saved 
chart. This is the same format required when importing a chart from text (see below). 

 Graph Title 
 Plot Title  
 
 This result was written at: Sun Apr 02 15:26:04 MDT 2017 
 
 Total number of lines is 2 
 Maximum number of values in a column is 9 
 
 X Axis Name is X Axis Label (meters) and   X Axis Type is 0 ( Linear ) 
 X Axis Range: low is 0.275 and high is 5.225 
 Y Axis Name is Y Axis Label (feet) and   Y Axis Type is 0 ( Linear ) 
 Y Axis Range: low is -4.4 and high is 4.4 
 Axes orientation is VERTICAL 
 
 X axis marker list has 0 markers: 
 The marker values are:  
 
 Y axis marker list has 0 markers: 
 The marker values are:  
 
 Name of the line #0 is Contour Line 
 Name of the line #1 is Parabola 
 
 
             x                 y                   x                 y 
      3.000E00         -3.000E00           5.000E-01          4.000E00 
      3.500E00          0.000E00            1.000E00          2.250E00 
      4.000E00          1.000E00            1.500E00          1.000E00 
      4.500E00         5.000E-01            2.000E00         2.500E-01 
      5.000E00         -2.000E00            2.500E00         1.000E-02 
      4.500E00         -2.500E00            3.000E00         2.500E-01 
      4.000E00         -2.750E00            3.500E00          1.000E00 
      3.500E00         -4.000E00            4.000E00          2.250E00 
      3.000E00         -3.000E00            4.500E00          4.000E00 

The first two lines of this file are the name of the chart and name of the plot. Next, the 
time that the file was saved is shown. The total number of curves on the chart and the 
maximum length of data arrays corresponding to these curves are on the following two 
lines. The number of lines on the chart is given next.  

The axes names, their type (Linear, Logarithmic, or Probability) as well as orientation 
(VERTICAL or HORIZONTAL) is written on the next three lines. The vertical 
orientation means that the vertical axis (y axis) represents the values of the function, and 
the horizontal axis (x axis) represents the independent variable. A horizontal orientation 
means the axes are switched: the y axis holds the independent variable and the x axis 
contains the value of the function. The next group of lines describes the labels placed on 
the plot: their quantity, their names and x, y coordinates.  
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The following two groups of lines list the markers of the x and y axes with their 
coordinates (values) on the axes. An x axis marker is a vertical line that crosses the x axis 
at a point called the marker value. Y axis markers are horizontal lines also described by 
their values on the y axis. The names (or legend names) of the curves are listed in the 
next group of lines. The rest of the file is the x and y values organized in columns 
representing the lines in the chart.  

Save a Line...  

When this sub-menu item is chosen, the user is presented with the list of all chart line 
names. Any one of these lines may be selected for saving to a text file. After the name is 
selected, a standard file save dialog will open so that the user can save the line to a text 
file. 

Below is an example file showing the format of a saved line. This is the same format 
required when importing a line from text (see below).  

 Contour Line 
 
 This result was written at: Sun Apr 02 21:09:08 MDT 2017 
  
 Number of value pairs is 9 
 
 X Axis Name is X Axis Label (meters)     Y Axis Name is Y Axis   Label 
(feet) 
 
                   x                 y 
             3.000E00         -3.000E00 
             3.500E00          0.000E00 
             4.000E00          1.000E00 
             4.500E00         5.000E-01 
             5.000E00         -2.000E00 
             4.500E00         -2.500E00 
             4.000E00         -2.750E00 
             3.500E00         -4.000E00 
             3.000E00         -3.000E00 
 
 The Line Color is java.awt.Color[r=255,g=85,b=85] 
 The Line Thickness is java.awt.BasicStroke@d1a007c0 

Import from Text  

This operation imports data from a text file, and recreates a chart, or adds a line to a 
chart. It has two submenu options: Import Text Chart and Import Text Line. After a chart 
or line is saved in a text file, the user can view the file in a text editor and edit the file. If 
a “mistake” is made in editing the text, the file may not import properly, and it may cause 
the software to throw an exception, or to lock up.  
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Import Text Chart...  

Selecting this submenu opens a standard file dialog to choose the file to import. Once the 
file is selected, a new chart is created from the text file.  

Import Text Line...  

Selecting this submenu allows the user to choose a text file describing a line. Once the 
file is selected, the line is added to the chart. Note that the software does not check the 
units for the line. The user must ensure that the units of the imported line match the chart 
units.  

Export  

When a chart or line is exported, it is saved to a file in a special Java™ format called a 
“serialized” object. This file format has a lot of special characters, and is not human 
readable. When a chart or line is imported, the software reads the serialized format, and 
restores the line or chart. If any character is edited or changed in an exported file, the 
import of the line or chart will probably fail. Also, if the plotting software is updated to a 
new version it may not import charts and lines exported in an earlier version. Finally, the 
Java™ Runtime Environment may not be able to import charts and lines saved with 
different runtime environment versions. The user may want to use a “.obj” file extension 
for this type of file, to make the file readily identifiable in the file browser. 

Export Chart...  

Selecting this submenu allows the user to choose a directory and file name to export the 
serialized chart to.  

Export a Line  

Upon a selection of this option, the user is presented with a list of the chart line names. 
When a line from the list is chosen, a file chooser window appears that prompts to define 
a file for saving the serialized line data. 

Import  

These menu items are used to restore the information saved during the serialized export 
operations. They recreate a chart or a line exported to a file in the serialized format. 
When a line is imported to a chart, the user must ensure that the line being restored and 
the chart it is restored to have the same units.  

Import Chart...  

Selecting this submenu opens a file dialog to choose the file to import. Once the file is 
selected, a new chart is created from the serialized object file.  



18 
 

Import a Line...  

Selecting this submenu allows the user to choose a file containing a line of data. Once the 
file is selected, the line is added to the chart. Note that the software does not check the 
units for the line. The user must ensure that the units of the imported line match the chart 
units.  

Close  

The last submenu of the file menu closes the chart window.  

Edit Lines Menu  

This menu gives the user a number of choices for editing the chart lines. It may be 
accessed by using the menu bar or shortcut key combination Alt+e (Windows), or 
Control+Option+e (Macintosh). When a line is changed, the legend and the submenu list 
of line names is automatically updated as needed.  

Delete All Lines...  

The choice of this item brings up a warning window requesting a confirmation of this 
action to prevent inadvertent erasing of all the lines on the chart. If the deletion is 
confirmed by the user, all lines on the chart will be cleared.  

Delete a Line  

Selecting this submenu will show the list of the line names. When a line name is selected, 
a confirmation window will ask if the user wants to delete the line. If the deletion is 
confirmed, the line is deleted from the chart.  

Copy a Line  

This choice of the selected line in the submenu list copies that line so that it can be pasted 
into another chart.  

Paste a Line  

This submenu item action pastes a copied line to the chart. The user needs to ensure the 
compatibility of the pasted line with the chart. The axis units must match for the chart to 
make sense.  

Cut a Line  

This option removes the submenu-selected line from the chart and copies it, so it can be 
pasted into another chart.  
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Change a Line Color  

This selection allows the user to change a line’s color by selecting the line from the 
submenu list. Doing so will bring up a color chooser window (see Figure 4) and the new 
color can be selected from the pallet.  

 

Figure 4: Color pallet brought up when changing a line color. Select the desired color and 
click "OK". 

Change Line Type  

Selecting this menu item for a given line in the submenu list brings up a pull-down menu 
that will allow you to choose a different line type than the default thin, solid line (see 
Figure 5). Note: due to a bug in the JFreeChart code, changing the line type to a different 
line type may cause the line to disappear during zooming operations. Selecting Auto 
Scale both axes under the Graph Manipulation menu will cause the line to reappear.  
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Figure 5: Changing a line type. Here the Contour Line has been selected and changed to a 
dashed line via the popup line-type selector (not shown). 

Change Line Label  

This submenu allows you to change the legend name for a line in the chart. Selecting this 
option will bring up a popup frame showing the current line label. The user can edit the 
label and click “OK” to change it. The name will be changed in the legend and in all the 
submenus that show the list of line names.  



21 
 

Show Line or Data 

This submenu allows you to toggle back and forth between showing the data as a 
connected line or as the individual data points. If a line is currently being shown as a 
connected line, selecting that line from the submenu list will toggle it to show just the 
data points and vice versa.  

 

Figure 6: Here the Parabola line has been toggled via the Show Line or Data option to 
show data only. 

 
Axes Menu  

This menu is used to make changes to the default axes settings. It may be accessed by 
using the menu bar or shortcut key combination Alt+a (Windows), or Control+Option+a 
(Macintosh).  

Select Axis Type  

This option allows switching between linear, logarithmic and probability scaling for 
either the x or the y axis (which show up as submenu options when this option is 
highlighted). The logarithmic axis labels are in exponential format, e.g. 1e0, 1e1, etc. The 
probability scale is derived from the inverse normal distribution function. The advantage 
of the probability scale is that samples that are approximately normally distributed fall on 
a straight line on such a graph. Furthermore, if the X-scale is logarithmic, a lognormal 
distribution would be a straight line. 
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When selecting a logarithmic axis type, if the data you’re plotting (or the axis scale 
marks, see remarks below) contains values less than or equal to 0.0, the program will 
return the following error popup: 

 

Figure 7: Attempting to convert to a log axis when you have values less than or equal to 
0.0 will result in this warning. 

This can be remedied by rescaling the data by hand (for example, by saving the line as 
text then editing the line file with rescaled values, then re-importing the new line. See the 
File Menu section) then retrying. If this error occurs even though your data contains all 
strictly positive values, then the axis currently displayed may contain values less than or 
equal to 0.0. To get around this, temporarily zoom in (or otherwise rescale, see Graph 
Manipulation Menu section) the axis that contains the offending values until all the axis 
values are strictly positive, then try the option again.  

Reverse Axes  

Selecting this submenu shows the independent variable values (domain) on the vertical 
(y) axis and the function values (range) on the horizontal (x) axis (See Figure 8 for the 
submenu, and Figure 9 for a reversed axis plot). Selecting this menu item again will 
restore the axes to their original location.  

 

Figure 8: The Reverse Axes menu option 
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Figure 9: The resultant graph after reversing the axes. 

Minor Tick Marks 

The default axis marking is to have only the major tick marks present, but if the user 
desires to see a set of minor tick marks between the major ticks on one or both axes, this 
option can be selected bringing up a submenu of numbers between 0 and 10. Selecting 0 
or 1 effectively turns the minor tick marks off. 

Tools Menu  

The tools menu comprises a series of check box options as well as other submenus that 
allow for the manipulation of the labels and markers. It may be accessed by using the 
menu bar or shortcut key combination Alt+t (Windows), or Control+Option+t 
(Macintosh). There is also a choice to restore the plot to its original condition, when it 
was first drawn.  

Show Data Points  

Checking this box will display the data points for the chart lines (see Figure 10). The data 
points may be shown by themselves or on top of lines if the Show Lines menu is checked.  
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Figure 10: The result of invoking Show Data Points. 

Hide Data Points  

This submenu selection will eliminate the display of the separate data points from the 
chart. The data in this case is presented as smooth lines, and the Show Lines box will be 
checked automatically.  

Show Lines  

The data points are connected with straight line segments when this box is checked.  

Hide Lines  

When this box is checked, the lines connecting consecutive data points are not drawn on 
the chart (See Figure 11). With selection of this box the data will be represented by the 
separate data points, and the Show Data Points submenu will be checked automatically.  
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Figure 11: The result of invoking Hide Lines. 

Show Legend  

This check box shows the legend of line names and types. The legend contains the 
user-provided names of the lines/point-sets. The default position of the legend bar is at 
the bottom center of the chart.  

Hide Legend  

Selecting this submenu will hide the legend. 

Show Click Coordinates  

The click coordinates are the coordinates of a point on the plot that has been clicked on 
with the mouse. When this submenu is selected, the x and y coordinates of the point are 
displayed along with dashed crosshairs (See Figure 12). The point coordinates are shown 
until another point is clicked.  
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Figure 12: With the Show Click Coordinates option, clicking on the graph displays the x 
and y lines corresponding to the clicked point. To remove these lines, use the Hide Click 

Coordinates option. 

Hide Click Coordinates  

Selecting this submenu hides the crosshair lines and coordinates.  

Move Legend Horizontally  

This submenu enables the user to move the legend bar horizontally to one of three 
positions: Right, Center, and Left relative to the plot area. 

Right  

The choice puts the legend bar in the rightmost position on the current vertical level. (See 
Figure 13) 

Center  

This choice centers the legend bar on the current vertical level.  
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Left  

This choice places the legend bar in the leftmost position on the current vertical level.  

 

Figure 13: Moving the legend to the right (default position is in the center). 

Move Legend Vertically  

This option enables the user to change vertical position of the legend bar Up or Down to 
one of two locations: just above or just below the plot. The horizontal position of the bar 
remains the same.  

Up  

This selection moves the legend bar to the top of the chart if it was at the bottom of the 
chart, otherwise no action is taken. (See Figure 14.) 

Down  

This selection moves the legend bar to the bottom of the chart if it was at the top of the 
chart, otherwise no action is taken.  
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Figure 14: Moving the legend up (default position is on bottom). 

Labels  

This submenu has the following choices: Add Label..., Change Label, Remove Label, and 
Clear All Labels... These submenus manipulate the labels that are text strings that can be 
placed anywhere in the plot area.  

Add Label...  

This selection allows the user to put a new label on the chart. It shows a dialog window 
with three fields: two for the x and y coordinates of the new label middle point, and one 
for the label text (see Figure 15). Initially, the text field for the label is empty and the 
number fields display the coordinate center of the plot. The coordinates are expressed in 
units of the corresponding axes. The user may overwrite these coordinates to place the 
label at a desirable position on the plot. The coordinate values must be in the range of 
their axes. If a coordinate falls outside of this interval, an out of range message will 
appear when the Done button is pressed. In this case, the user needs to correct the value 
and press the Done button again. The Cancel button closes the dialog window without 
adding a label. Figure 16 shows the graph with two labels added. 
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Figure 15: The Label Input popup frame used to add or change a label on the graph. 

 

Figure 16: Graph with labels added 

Remove Label  

This submenu selection displays the list of the chart labels. Choosing one of them 
removes this label from the plot after your intention is confirmed using a confirmation 
dialog.  
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Clear All Labels...  

Selecting this menu item will display a warning asking the user to confirm that all of the 
labels on the chart should be deleted. After the confirmation, all labels are eliminated 
from the plot.  

Markers  

This submenu allows the user to manage axis markers for the x and y axes. The markers 
are horizontal or vertical lines that are drawn on the plot and defined by an axis 
coordinate. Manipulation of the markers is done for each axis separately with the 
submenu options X Axis Markers and Y Axis Markers. Selecting either of these menu 
items shows submenus to add a marker, remove a marker, or clear all markers.  

Add Marker...  

When this submenu is selected, a dialog will be shown to enter a new marker. (See Figure 
17.) After entering the coordinate and pressing the Done button, the marker will be 
displayed on the plot. (See Figure 18.) 

 

Figure 17: The Marker Input dialog popup. 

Remove Marker  

Any marker of an axis may be selected from the list of the axis markers for removal. The 
user will be asked to confirm the removal.  
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Figure 18: Marker added at the value x = 3.5. 

Clear All Markers...  

The user can remove all markers from an axis. The user will be asked to confirm the 
removal of all of the markers.  

Restore Original Chart...  

The last sub-menu in the tools menu gives the user an option to erase all changes made to 
the chart in a current session. On selection of this option a message asking the user to 
confirm this decision will appear.  

Graph Manipulation Menu  

This menu controls graph properties, the graph size, and zooming options. It may be 
accessed by using the menu bar or shortcut key combination Alt+g (Windows), or 
Control+Option+g (Macintosh). There are a variety of zooming options in the Graph 
Manipulation menu: zooming in or out both axes at the same time, or zooming only one 
axis, or using automatic scaling of one or both axes. Note: the right mouse click in the 
plot area pops up a menu with choices of Properties, Print, and Zoom that are similar to 
those invoked from the File and Graph Manipulation menus. The Save as option from 
this menu gives an opportunity to save the chart as a PNG file.  
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Edit graph properties  

This selection opens a dialog window (see Figure 20) with three tabs: Title, Plot, and 
Other. The same dialog can be opened by right-clicking on the chart (see Figure 19) and 
selecting “Properties...”  

 

Figure 19: The right click menu. By right-clicking on the graph the options under the 
Graph Manipulation Menu can be more convenient. 
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Figure 20: The Chart Properties dialog which appears when selecting "Edit graph 
properties" from the Graph Manipulation Menu or by right clicking and selecting 

"Properties..." 

Title  
The title tab (see Figure 20) handles the look of the graph title: text, font, and color.  

Plot  
The plot tab (see Figure 21) is responsible for the overall plot appearance, its outlines, 
background, and orientation.  

Domain and Range Axes  
The Domain and Range Axis sub-tabs allow the user to customize the chart axes. The 
user can change the label of an axis in the Label line; select a new font or a new color. 
The Ticks tab at the bottom of this window (see Figure 22) gives a choice of showing or 
hiding tick labels and the marks. The ranges of the axes (minimum and maximum values) 
may be changed when the Range Axis tab is selected. If the Auto-adjust range box is 
clicked on, they display extreme axis coordinates of the plot. If this box is clicked off, the 
values may be changed.  
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Figure 21: The Plot tab on the Chart Properties Editor 

Appearance  
This tab controls outline stroke, outline and background paint, and the plot orientation. 
Changing the Orientation has the same effect as selecting the Axes: Reverse Axes menu 
item.  

Other  
The implementation of the Other tab (see Figure 22) allows choosing a background color 
and checking the Draw anti-aliased box. No editors are implemented for changing series 
paint, series stroke, series outline paint, and series outline stroke in this window. When 
the background paint select button is pressed, the user is presented with a new window 
showing a color chooser to select a new background color. With the anti-aliasing turned 
on, the plot lines are smoothed; otherwise they are drawn with short horizontal or vertical 
segments corresponding to the underlying data. Selecting Draw anti-aliased (the default), 
gives the plot a smooth and crisp look. As usual, all changes made may be canceled or 
approved by the user before closing this dialog.  
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Figure 22: The Other tab allows choosing a background color and/or the choice of anti-
aliased drawing. 

Change x, y Axes Tick Sizes...  

This submenu allows modification of the major tick. For example, the ticks of both x and 
y axes on the plot of Figure 19 are equal to 0.25. When this option is selected, a dialog 
for entering new values will appear (see Figure 23). Initially, it contains the current tick 
values. After the new values have been entered and the Done button is pressed, the new 
tick spacing will show on the axes. Note: for the logarithmic type of axis the tick size 
change has no effect.  

 

Figure 23: Choosing the tick sizes for the axes. 
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Resizing Plot Boundaries  

This menu selection brings out a dialog for entering a new width and height of the plot 
window. It opens with the current width and height in pixels and expects the new values 
in pixels to be entered. If an entered number is too small or too big, the out of range 
warning will appear that gives the range of possible values. The upper limit is pretty large 
and the width of the plot is going to be limited by the width of the screen. The plot also 
can be resized by dragging the sides or corners of the plot window.  

 

Figure 24: The resizing editor allows the user to select exact number of pixels for the 
chart size. 

Zoom in both axes  
This menu selection displays a part of the plot corresponding to a smaller range of values 
of both axes. The same effect can also be achieved by clicking in the plot area and 
“stretching” a rectangle from its left upper corner to the lower right corner for a new plot 
area. In the top portion of Figure 25, the colored rectangle in the lower right corner was 
created by dragging the rectangle from its upper left corner. The lower portion of Figure 
25 shows the zoomed in plot, after the mouse button is released in the lower right corner 
of the rectangle. 

Zoom out both axes  

This operation reverses the previous action, it restores the display of the larger portions of 
each axis. The Zooming out effect can also be achieved by clicking in the plot area and 
dragging a rectangle up and to the left. Regardless of the size of the dragged rectangle, 
the zoom out action will show the entire graph.  

Zoom in x axis, Zoom in y axis  
The action displays a part of the plot corresponding to a smaller range of values of the 
corresponding axis.  
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Zoom out x axis, Zoom out y axis  
The previous operation may be reversed with this option; it restores a previous range of 
values of the corresponding axis.  

 

 

 

Figure 25: Left-clicking in the graph area and dragging creates a rectangle that allows 
precise zoom control. 
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Auto Scale (both, x axis, y axis) 
These choices bring the display of the axes back to the full range of the values of the 
independent variable and the dependent variable.  

Help Menu 
The Help menu provides explanation for each of the menu options for the XY Plot. It 
may be accessed by using the menu bar or shortcut key combination Alt+h (Windows), or 
Control+Option+h (Macintosh). Under the Help menu, there are five submenu options 
corresponding to the five menus at the top of the graph frame.  

The Bar Plot 
The second type of plot available in the LANL Plotting Software is the Bar Plot (see 
Figure 26). Much of the capability is completely analogous to that shown in the XY Plot 
section, however, Bar Plot specific details will be described here.  

 

 

Figure 26: A Bar Plot with five sets of bars plotted 
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File Menu 
The File Menu for the Bar Plot tool offers the analogous functions to that of the XY Plot 
tool so the reader is directed to the XY Plot, File Menu section for details on the menu 
item functionality that are not included here. It may be accessed by using the menu bar or 
shortcut key combination Alt+f (Windows), or Control+Option+f (Macintosh). Figure 27 
shows the File Menu options available. 

 

Figure 27: The Bar Plot File Menu is the same as that of the XY Plot, however, the 
specific submenus differ in the ability to save a Bar Group (instead of a Line in the case 

of the XY Plot) 

A Bar Plot specific detail is that a Bar Group can be saved, imported and exported 
separately from the chart as a whole (analogous to a Line in the XY Plot case).  

An example file is presented below to illustrate the format for the text files for saving and 
importing a Bar Group: 
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Target Types 
Target Types by Country 
This result was written at: Mon Apr 03 17:06:21 MDT 2017 
Domain Axis Name is Country Code 
Range Axis Name is Number of Targets 
Range Axis: low is 0.0 and high is 52.5 
Range Axis Type is 0 ( LINEAR ) 
Axes orientation is VERTICAL 
 
 
The chart has 0 labels: 
 
          Bar Value         Bar Name        Bar Group Name 
          5.000E01          P type          Total 
          3.500E01          P type          US 
          2.000E00          P type          UK 
          1.000E00          P type          FR 
          1.200E01          P type          CA 
          2.000E01          Q type          Total 
          1.500E01          Q type          US 
          1.000E00          Q type          UK 
          2.000E00          Q type          FR 
          2.000E00          Q type          CA 
          2.600E01          Z type          Total 
          2.200E01          Z type          US 
          2.000E00          Z type          UK 
          2.000E00          Z type          FR 
          4.000E00          G type          Total 
          2.000E00          G type          US 
          1.000E00          G type          UK 
          1.000E00          G type          FR 

 

The first two lines of this file are the name of the chart and name of the plot. Next, the 
time that the file was saved is shown.  

The axes names are next preceded by “Domain Axis Name is” and “Range Axis Name 
is”. After that is the “Range Axis: low is <min value> and high is <max value>” and the 
Range Axis Type (LINEAR or LOG) and orientation (VERTICAL or HORIZONTAL). 

The next grouping lists the number of labels present followed by three tab-separated 
columns with headers: Bar Value, Bar Name and Bar Group Name. The contents of each 
column are the numeric value of the bar data, the string describing the category of the bar 
and the string describing the bar group, respectively.  

 

 

In a similar manner, the format for the text output/input for a bar group is: 

This result was written at: Tue Apr 04 12:01:10 MDT 2017 
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          Bar Value         Bar Name        Bar Group Name 
          3.500E01          P type          US 
          1.500E01          Q type          US 
          2.200E01          Z type          US 
          2.000E00          G type          US 

Edit Bars Menu 

This menu gives the user a number of choices for editing the chart Bars and Bar Groups. 
It may be accessed by using the menu bar or shortcut key combination Alt+e (Windows), 
or Control+Option+e (Macintosh). When a Bar or Bar Group is changed, the legend and 
the submenu list of Bar and Bar Group names is automatically updated as needed.  

Delete All Bars...  

The choice of this item brings up a warning window requesting a confirmation of this 
action to prevent inadvertent erasing of all the bars on the chart. If the deletion is 
confirmed by the user, all bars on the chart will be cleared.  

Delete a Bar  

Selecting this submenu will show the list of the bar names. When a bar name is selected, 
a confirmation window will ask if the user wants to delete the bar. If the deletion is 
confirmed, the bar is deleted from the chart.  

Change Bar Color  

This selection allows the user to change a bar’s color by selecting the bar name from the 
submenu list. Doing so will bring up a color chooser window (see Figure 4) and the new 
color can be selected from the pallet.  

Delete a Bar Group 

Selecting this submenu will show the list of the bar group names. When a bar group name 
is selected, a confirmation window will ask if the user wants to delete the bar group. If 
the deletion is confirmed, the bar group is deleted from the chart.  

Copy a Bar Group  

This choice of the selected bar group in the submenu list copies that bar group so that it 
can be pasted into another chart.  
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Paste a Bar Group  

This submenu item action pastes a copied bar group to the chart. The user needs to ensure 
the compatibility of the pasted bar group with the chart. The axis units must match for the 
chart to make sense.  

Cut a Bar Group  

This option removes the submenu-selected bar group from the chart and copies it, so it 
can be pasted into another chart.  

Change Bar Label  

This submenu allows you to change the legend name for a bar in the chart. Selecting this 
option will bring up a popup frame showing the current bar label (see Figure 28). The 
user can edit the label and click “OK” to change it. The name will be changed in the 
legend and in all the submenus that show the list of bar names.  

 

Figure 28: The Change Bar Label popup dialog 

Change Bar Group Label  
This submenu allows you to change the legend name for a bar group in the chart. 
Selecting this option will bring up a popup frame showing the current bar group label 
(see Figure 29). The user can edit the label and click “OK” to change it. The name will be 
changed in the legend and in all the submenus that show the list of bar group names.  

 

Figure 29: The Change Bar Group Label popup dialog 
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Axes Menu 
This menu is used to make changes to the default axes settings. It may be accessed by 
using the menu bar or shortcut key combination Alt+a (Windows), or Control+Option+a 
(Macintosh).  

Reverse Axes  
Selecting this submenu shows bars on the vertical (y) axis and the bar values on the 
horizontal (x) axis (See Figure 30). Selecting this menu item again will restore the axes to 
their original location.  

 

Figure 30: Reversing the axes on the Bar Plot puts the values on the horizontal (x) axis 
and the bars on the vertical (y) axis. Choosing the option one more time restores it to the 

default. 

Minor Tick Marks 

The default axis marking is to have only the major tick marks present, but if the user 
desires to see a set of minor tick marks between the major ticks on the range axis (which 
is vertical by default, but may be changed to the horizontal), this option can be selected 
bringing up a submenu of numbers between 0 and 10. Selecting 0 or 1 effectively turns 
the minor tick marks off. Figure 31 shows the resulting vertical axis when a minor tick 
value of 5 is chosen. 
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Figure 31: The resulting vertical axis when a minor tick value of 5 is chosen. 

Tools Menu  
The tools menu comprises a series of check box options as well as other submenus that 
allow for the manipulation of the labels and markers. It may be accessed by using the 
menu bar or shortcut key combination Alt+t (Windows), or Control+Option+t 
(Macintosh). There is also a choice to restore the plot to its original condition, when it 
was first drawn.  

Show Legend  
This check box shows the legend of line names and types. The legend contains the user-
provided names of the bars. The default position of the legend bar is at the bottom center 
of the chart.  

Hide Legend  
Selecting this submenu will hide the legend. 

Move Legend Horizontally  
This submenu enables the user to move the legend bar horizontally to one of three 
positions: Right, Center, and Left relative to the plot area. 
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Right  
The choice puts the legend bar in the rightmost position on the current vertical level (see 
Figure 32).  

 

Figure 32: Bar Plot legend moved to the right 

Center  
This choice centers the legend bar on the current vertical level.  

Left  
This choice places the legend bar in the leftmost position on the current vertical level.  

Move Legend Vertically  
This option enables the user to change vertical position of the legend bar Up or Down to 
one of two locations: just above or just below the plot. The horizontal position of the bar 
remains the same.  

Up  
This selection moves the legend bar to the top of the chart if it was at the bottom of the 
chart, otherwise no action is taken (analogous to Figure 14 in the XY Plot section). 
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Down  
This selection moves the legend bar to the bottom of the chart if it was at the top of the 
chart, otherwise no action is taken.  

Labels  
This submenu has the following choices: Add Label..., Change Label, Remove Label, and 
Clear All Labels... These submenus manipulate the labels that are text strings that can be 
placed anywhere in the plot area.  

Add Label...  
This selection allows the user to put a new label on the chart. It shows a dialog window 
with three fields: two for the x and y coordinates of the new label middle point, and one 
for the label text (see Figure 33). Initially, the text field for the label is empty and the 
number fields display the coordinate center of the plot. The X-coordinate can be chosen 
from a drop-down menu of the bar groups. The Y-coordinate is expressed in units of the 
Y-axis on the chart. The user may overwrite these coordinates to place the label at a 
desirable position on the plot. The Y-coordinate value must be in the range of its 
displayed axis interval. If the value falls outside of this interval, an out of range message 
will appear when the Done button is pressed. In this case, the user needs to correct the 
value and press the Done button again. The Cancel button closes the dialog window 
without adding a label. Figure 34 shows the graph with a label added to the US bar group. 

 

Figure 33: The Add or Change Label popup dialog box has a drop-down chooser for the 
X-coordinate and a numeric value for the Y. 
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Figure 34: The new label added to the chart. 

Remove Label  
This submenu selection displays the list of the chart labels. Choosing one of them 
removes this label from the plot after your intention is confirmed using a confirmation 
dialog.  

Clear All Labels...  
Selecting this menu item will display a warning asking the user to confirm that all of the 
labels on the chart should be deleted. After the confirmation, all labels are eliminated 
from the plot.  

Restore Original Chart...  
The last sub-menu in the tools menu gives the user an option to erase all changes made to 
the chart in a current session. On selection of this option a message asking the user to 
confirm this decision will appear.  

Graph Manipulation Menu  
This menu controls graph properties, the graph size, and zooming options. It may be 
accessed by using the menu bar or shortcut key combination Alt+g (Windows), or 
Control+Option+g (Macintosh). There are a variety of zooming options in the Graph 
Manipulation menu: zooming in or out both axes at the same time, or zooming only one 
axis, or using automatic scaling of one or both axes. Note: the right mouse click in the 
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plot area pops up a menu with choices of Properties, Print, and Zoom that are identical 
to those invoked from the File and Graph Manipulation menus. The Save as option from 
this menu gives an opportunity to save the chart as a PNG file.  

Edit graph properties  
This selection opens a dialog window (analogous to the XY Plot in Figure 20) with three 
tabs: Title, Plot, and Other. The same dialog can be opened by right-clicking on the chart 
(see Figure 20) and selecting “Properties...”  See the XY Plot Graph Manipulation Menu 
section for a complete description of this capability. 

Zoom in both axes  
This menu selection displays a part of the plot corresponding to a smaller range of values 
of both axes. The same effect can also be achieved by clicking in the plot area and 
“stretching” a rectangle from top to bottom (or vice versa) for a new plot area (see Figure 
35).  

 

Figure 35: Left-clicking in the graph area and dragging creates a new rectangle for 
zooming. 

Zoom out both axes  
This operation reverses the previous action, it restores the display of the larger portions of 
each axis.  
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Zoom in x axis, Zoom in y axis  
The action displays a part of the plot corresponding to a smaller range of values of the 
corresponding axis.  

Zoom out x axis, Zoom out y axis  
The previous operation may be reversed with this option; it restores a previous range of 
values of the corresponding axis. The Zooming out effect can also be achieved by 
clicking in the plot area and moving the pointer right to left or upward.  

Auto Scale  
These choices bring the display of the axes back to the full range of the values of the 
independent variable and the function.  

Help Menu 
The Help menu provides explanation for each of the menu options for the Bar Plot. It 
may be accessed by using the menu bar or shortcut key combination Alt+h (Windows), or 
Control+Option+h (Macintosh). Under the Help menu, there are five submenu options 
corresponding to the five menus at the top of the graph frame.  

The Histogram Plot 
A third type of plot available in the LANL Plotting Software is the Histogram Plot (see 
Figure 36). Again, much of the capability is completely analogous to that shown in the 
XY Plot and Bar Plot sections.  

Figure 36: The Histogram Plot tool 
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File Menu 
The File Menu for the Histogram Plot tool offers some of the analogous functions to that 
of the XY Plot tool so the reader is directed to the XY Plot, File Menu section for details 
on the menu item functionality that are not included here. The File Menu may be 
accessed by using the menu bar or shortcut key combination Alt+f (Windows), or 
Control+Option+f (Macintosh). Figure 37 shows the File Menu options available. 
Absent from the Histogram Plot File Menu are the options “Save as Text” and “Import 
from Text”.  

 

Edit Histograms Menu 
This menu gives the user a number of choices for editing the chart histogram. It may be 
accessed by using the menu bar or shortcut key combination Alt+e (Windows), or 
Control+Option+e (Macintosh). When a histogram is changed, the legend and the 
submenu list of histogram names is automatically updated as needed.  

Delete All Histograms...  
The choice of this item brings up a warning window requesting a confirmation of this 
action to prevent inadvertent erasing of all the histograms on the chart. If the deletion is 
confirmed by the user, all histograms on the chart will be cleared.  

Figure 37: The Histogram Plot File Menu options 
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Delete a Histogram  
Selecting this submenu will show the list of the histogram names. When a histogram 
name is selected, a confirmation window will ask if the user wants to delete the 
histogram. If the deletion is confirmed, the histogram is deleted from the chart.  

Copy a Histogram 
This choice of the selected histogram in the submenu list copies that histogram so that it 
can be pasted into another chart.  

Paste a Histogram 
This submenu item action pastes a copied histogram to the chart. The user needs to 
ensure the compatibility of the pasted histogram with the chart. The axis units must 
match for the chart to make sense.  

Cut a Histogram  
This option removes the submenu-selected histogram from the chart and copies it, so it 
can be pasted into another chart.  

Change Histogram Color  
This selection allows the user to change a histogram’s color by selecting the histogram 
name from the submenu list. Doing so will bring up a color chooser window (refer back 
to Figure 4) and the new color can be selected from the pallet.  

Change Histogram Label  
This submenu allows you to change the legend name for a histogram in the chart. 
Selecting this option will bring up a popup frame showing the current histogram label 
(see Figure 38). The user can edit the label and click “OK” to change it. The name will be 
changed in the legend and in all the submenus that show the list of histogram names.  

 

Figure 38: The Change Histogram Label popup dialog. 

Axes Menu 
This menu is used to make changes to the default axes settings. It may be accessed by 
using the menu bar or shortcut key combination Alt+a (Windows), or Control+Option+a 
(Macintosh).  
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Reverse Axes  
Selecting this submenu shows the histogram on the vertical (y) axis and the values on the 
horizontal (x) axis (See Figure 39). Selecting this menu item again will restore the axes to 
their original location.  

 

Figure 39: Reversing the axes on the Histogram Plot puts the values on the horizontal (x) 
axis and the histogram bars on the vertical (y) axis. Choosing the option one more time 

restores it to the default. 

Minor Tick Marks 
The default axis marking is to have only the major tick marks present, but if the user 
desires to see a set of minor tick marks between the major ticks on one or both axes, this 
option can be selected bringing up a submenu of numbers between 0 and 10. Selecting 0 
or 1 effectively turns the minor tick marks off. Refer back to figure 31 to see the resulting 
change to the vertical axis when a minor tick value of 5 is chosen. 

Tools Menu  
The tools menu comprises a series of check box options as well as other submenus that 
allow for the manipulation of the labels and markers. It may be accessed by using the 
menu bar or shortcut key combination Alt+t (Windows), or Control+Option+t 
(Macintosh). There is also a choice to restore the plot to its original condition, when it 
was first drawn. The options and functionality for the Tools menu is exactly analogous 
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with that in the Bar Plot Section with the addition of Show/Hide Click Coordinates and 
Markers, which we explain below. 

Show Click Coordinates  
The click coordinates are the coordinates of a point on the plot that has been clicked on 
with the mouse. When this submenu is selected, the x and y coordinates of the point are 
displayed along with dashed crosshairs (see Figure 40. The point coordinates are shown 
until another point is clicked.  

Hide Click Coordinates  
Selecting this submenu hides the crosshair lines and coordinates.  

 

Figure 40: With the Show Click Coordinates option, clicking on the graph displays the x 
and y lines corresponding to the clicked point. To remove these lines, use the Hide Click 

Coordinates option. 

Markers  
This submenu allows the user to manage axis markers for the x and y axes. The markers 
are horizontal or vertical lines that are drawn on the plot and defined by an axis 
coordinate. Manipulation of the markers is done for each axis separately with the 
submenu options X Axis Markers and Y Axis Markers. Selecting either of these menu 
items shows submenus to add a marker, remove a marker, or clear all markers.  
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Add Marker...  
When this submenu is selected, a dialog will be shown to enter a new marker for each 
axis (see Figure 41). After entering the coordinate and pressing the Done button, the 
marker will be displayed on the plot. Figure 42 shows the plot with the value 160 marked 
on the Y-axis. 

 

Figure 41: The Marker Input dialog popup for Histogram Plots. 

 

Figure 42: Marker added on the Y-axis at value 160. 
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Remove Marker  
Any marker of an axis may be selected from the list of the axis markers for removal. The 
user will be asked to confirm the removal.  

Clear All Markers...  
The user can remove all markers from an axis. The user will be asked to confirm the 
removal of all of the markers.  

Restore Original Chart...  
The last sub-menu in the tools menu gives the user an option to erase all changes made to 
the chart in a current session. On selection of this option a message asking the user to 
confirm this decision will appear.  

Graph Manipulation Menu  
This menu controls graph properties, the graph size, and zooming options. It may be 
accessed by using the menu bar or shortcut key combination Alt+g (Windows), or 
Control+Option+g (Macintosh). There are a variety of zooming options in the Graph 
Manipulation menu: zooming in or out both axes at the same time, or zooming only one 
axis, or using automatic scaling of one or both axes. Note: the right mouse click in the 
plot area pops up a menu with choices of Properties, Print, and Zoom that are identical 
to those invoked from the File and Graph Manipulation menus. The Save as option from 
this menu gives an opportunity to save the chart as a PNG file.  

The Graph Manipulation Menu for the Histogram Plot tool is exactly analogous to that 
for the XY Plot with all the same options and functionality. The user is referred to the XY 
Plot, Graph Manipulation Menu section of this document for detailed discussion. 

Help Menu 
The Help menu provides explanation for each of the menu options for the Histogram 
Plot. It may be accessed by using the menu bar or shortcut key combination Alt+h 
(Windows), or Control+Option+h (Macintosh). Under the Help menu, there are five 
submenu options corresponding to the five menus at the top of the graph frame.  

Date XY Plot 
A third type of plot available in the LANL Plotting Software is the Date XY Plot (see 
Figure 43). Again, much of the capability is completely analogous to that shown in the 
XY Plot and Bar Plot sections. The dates entered, although displayed in human readable 
dates, are processed using Unix computer time or seconds since Jan 1, 1970 0:00:00 GMT 
(there are plenty of websites available to convert a human readable date to Unix time). 
This will be needed when entering labels on the graph below. 
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Figure 43: The Date XY Plot 
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File Menu 
The File Menu for the Date XY Plot tool offers some of the analogous functions to that of 
the XY Plot tool so the reader is directed to the XY Plot, File Menu section for details on 
the menu item functionality that are not included here. It may be accessed by using the 
menu bar or shortcut key combination Alt+f (Windows), or Control+Option+f 
(Macintosh).  

 

Figure 44: Shows the File Menu options available. As with the Histogram Plot, absent 
from the Date XY Plot File Menu are the options “Save as Text” and “Import from Text”.  

Edit Lines Menu 
This menu gives the user a number of choices for editing the chart histogram. It may be 
accessed by using the menu bar or shortcut key combination Alt+e (Windows), or 
Control+Option+e (Macintosh). When a histogram is changed, the legend and the 
submenu list of histogram names is automatically updated as needed.  

Delete All Lines...  
The choice of this item brings up a warning window requesting a confirmation of this 
action to prevent inadvertent erasing of all the lines on the chart. If the deletion is 
confirmed by the user, all lines on the chart will be cleared.  
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Delete a Line  
Selecting this submenu will show the list of the line names. When a line name is selected, 
a confirmation window will ask if the user wants to delete the line. If the deletion is 
confirmed, the line is deleted from the chart.  

This choice of the selected line in the submenu list copies that line so that it can be pasted 
into another chart.  

Paste a Line  
This submenu item action pastes a copied line to the chart. The user needs to ensure the 
compatibility of the pasted line with the chart. The axis units must match for the chart to 
make sense.  

Cut a Line  
This option removes the submenu-selected line from the chart and copies it, so it can be 
pasted into another chart.  

Change a Line Color  
This selection allows the user to change a line’s color by selecting the line from the 
submenu list. Doing so will bring up a color chooser window (see Figure 4 in the XY Plot 
section) and the new color can be selected from the pallet.  

Change Line Type  
Selecting this menu item for a given line in the submenu list brings up a pull down menu 
that will allow you to choose a different line type than the default thin, solid line (see 
Figure 5 in the XY Plot section). Note: due to a bug in the JFreeChart code, changing the 
line type to a different line type may cause the line to disappear during zooming 
operations. Selecting Auto Scale both axes under the Graph Manipulation menu will 
cause the line to reappear.  

Change Line Label  
This submenu allows you to change the legend name for a line in the chart. Selecting this 
option will bring up a popup frame showing the current line label. The user can edit the 
label and click “OK” to change it. The name will be changed in the legend and in all the 
submenus that show the list of line names.  

Show Line or Data 
This submenu allows you to toggle back and forth between showing the data as a 
connected line or as the individual data points. If a line is currently being shown as a 
connected line, selecting that line from the submenu list will toggle it to show just the 
data points and vice versa.  

Tools Menu  
The tools menu comprises a series of check box options as well as other submenus that 
allow for the manipulation of the labels and markers. It may be accessed by using the 
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menu bar or shortcut key combination Alt+t (Windows), or Control+Option+t 
(Macintosh). There is also a choice to restore the plot to its original condition, when it 
was first drawn.  

Show Data Points  
Checking this box will display the data points for the chart lines (see Figure 45). The data 
points may be shown by themselves or on top of lines if the Show Lines menu is checked 

 

 

 

 

Figure 45: Data points shown in Date XY Plot 

Hide Data Points  
This submenu selection will eliminate the display of the separate data points from the 
chart. The data in this case is presented as smooth lines, and the Show Lines box will be 
checked automatically.  

Show Lines  
The data points are connected with straight line segments when this box is checked.  
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Hide Lines  
When this box is checked, the lines connecting consecutive data points are not drawn on 
the chart (See Figure 46). With selection of this box the data will be represented by the 
separate data points, and the Show Data Points submenu will be checked automatically.  

 

Figure 46: The resultant graph after hiding lines 

Show Legend  
This check box shows the legend of line names and types. The legend contains the user-
provided names of the lines/point-sets. The default position of the legend bar is at the 
bottom center of the chart.  

Hide Legend  
Selecting this submenu will hide the legend. 

Show Click Coordinates  
The click coordinates are the coordinates of a point on the plot that has been clicked on 
with the mouse. When this submenu is selected, the x and y coordinates of the point are 
displayed along with dashed crosshairs (see Figure 47). The point coordinates (date, 
value) are shown until another point is clicked.  
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Figure 47: The Show Click Coordinates option 

 
Hide Click Coordinates  

Selecting this submenu hides the crosshair lines and coordinates.  

Move Legend Horizontally  
This submenu enables the user to move the legend bar horizontally to one of three 
positions: Right, Center, and Left relative to the plot area (see The XY Plot section, 
Figure 13). 

Right  
The choice puts the legend bar in the rightmost position on the current vertical level.  

Center  
This choice centers the legend bar on the current vertical level.  

Left  
This choice places the legend bar in the leftmost position on the current vertical level.  
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Move Legend Vertically  
This option enables the user to change vertical position of the legend bar Up or Down to 
one of two locations: just above or just below the plot. The horizontal position of the bar 
remains the same.  

Up  
This selection moves the legend bar to the top of the chart (see the XY Plot section, 
Figure 14). If it was at the bottom of the chart, otherwise no action is taken.  

Down  
This selection moves the legend bar to the bottom of the chart if it was at the top of the 
chart, otherwise no action is taken.  

Labels  
This submenu has the following choices: Add Label..., Change Label, Remove Label, and 
Clear All Labels... These submenus manipulate the labels that are text strings that can be 
placed anywhere in the plot area.  

Add Label...  
This selection allows the user to put a new label on the chart. It shows a dialog window 
with three fields: two for the x and y coordinates of the new label middle point, and one 
for the label text (see Figure 48). Initially, the text field for the label is empty and the x, y 
fields display the coordinate center of the plot. The x-coordinate is expressed in date form 
and the y-coordinate is in the specified y-axis units. The user may overwrite these 
coordinates to place the label at a desirable position on the plot. The coordinate values 
must be in the range of their axes. If a coordinate falls outside of this interval, an out of 
range message will appear when the Done button is pressed. In this case, the user needs 
to correct the value and press the Done button again. The Cancel button closes the dialog 
window without adding a label. Figure 49 shows the graph with a label added. 

 

Figure 48: The Date XY Plot Label Input dialog 
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Figure 49: The Date XY Plot with label added. 
Remove Label  

This submenu selection displays the list of the chart labels. Choosing one of them 
removes this label from the plot after your intention is confirmed using a confirmation 
dialog.  

Clear All Labels...  
Selecting this menu item will display a warning asking the user to confirm that all of the 
labels on the chart should be deleted. After the confirmation, all labels are eliminated 
from the plot.  

Markers  
This submenu allows the user to manage axis markers for the x and y axes. The markers 
are horizontal or vertical lines that are drawn on the plot and defined by an axis 
coordinate. Manipulation of the markers is done for each axis separately with the 
submenu options X Axis Markers and Y Axis Markers. Selecting either of these menu 
items shows submenus to add a marker, remove a marker, or clear all markers.  
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Figure 50: The Date XY Plot Marker Input for the x-axis 

Add Marker...  
When this submenu is selected, a dialog will be shown (see Figure 50) to enter a new 
marker. After entering the coordinate and pressing the Done button, the marker will be 
displayed on the plot. Notice the date axis is in the format of, “MM/dd/yyyy hh:mm:ss”. 
Figure 51 shows the plot with a marker shown on the X (date) axis. 

Clear All Markers...  
The user can remove all markers from an axis. The user will be asked to confirm the 
removal of all of the markers.  

Remove Marker  
Any marker of an axis may be selected from the list of the axis markers for removal. The 
user will be asked to confirm the removal.  

Restore Original Chart...  
The last sub-menu in the tools menu gives the user an option to erase all changes made to 
the chart in a current session. On selection of this option a message asking the user to 
confirm this decision will appear.  
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Figure 51: The Date XY Plot with a marker on the date axis 

Graph Manipulation Menu  
This menu controls graph properties, the graph size, and zooming options. It may be 
accessed by using the menu bar or shortcut key combination Alt+g (Windows), or 
Control+Option+g (Macintosh). There are a variety of zooming options in the Graph 
Manipulation menu: zooming in or out both axes at the same time, or zooming only one 
axis, or using automatic scaling of one or both axes. Note: the right mouse click in the 
plot area pops up a menu with choices of Properties, Print, and Zoom that are identical 
to those invoked from the File and Graph Manipulation menus. The Save as option from 
this menu gives an opportunity to save the chart as a PNG file.  

Edit graph properties  
This selection opens a dialog window (see the XY Plot section, Figure 20) with three 
tabs: Title, Plot, and Other. The same dialog can be opened by right-clicking on the chart 
(see the XY Plot section, Figure 19) and selecting “Properties...”  

Title  
The title tab (see Figure 20) handles the look of the graph title: text, font, and color.  

Plot  
The plot tab (see Figure 21) is responsible for the overall plot appearance, its outlines, 
background, and orientation.  
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Domain and Range Axes  
The Domain and Range Axis sub-tabs allow the user to customize the chart axes. The 
user can change the label of an axis in the Label line; select a new font or a new color. 
The Ticks tab at the bottom of this window (see Figure 21) gives a choice of showing or 
hiding tick labels and the marks. The ranges of the axes (minimum and maximum values) 
may be changed when the Range tab is selected. If the Auto-adjust range box is clicked 
on, they display extreme axis coordinates of the plot. If this box is clicked off, the values 
may be changed.  

Appearance  
This tab controls outline stroke, outline and background paint, and the plot orientation. 
Changing the Orientation has the same effect as selecting the Axes: Reverse Axes menu 
item.  

Other  
The implementation of the Other tab (see Figure 22) allows choosing a background color 
and checking the Draw anti-aliased box. No editors are implemented for changing series 
paint, series stroke, series outline paint, and series outline stroke in this window. When 
the background paint select button is pressed, the user is presented with a new window 
showing a color chooser to select a new background color. With the anti-aliasing turned 
on, the plot lines are smoothed; otherwise they are drawn with short horizontal or vertical 
segments corresponding to the underlying data. Selecting Draw anti-aliased (the default), 
gives the plot a smooth and crisp look. As usual, all changes made may be canceled or 
OKed by the user before closing this dialog.  

Set date axis tick size 
This submenu allows modification of the major tick on the date axis with three options, 
Day, Week, and Month (see Figure 52). Figure 53 shows how the date axis changes with 
the Month option chosen.  
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Figure 52: Setting the date tick size 

 

Figure 53: The date tick size set to Month 
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Figure 54: Setting the date axis tick label orientation to Vertical 
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Set date axis tick label orientation 
This submenu allows modification of the major tick on the date axis with two options: 
Vertical and Horizontal. Figure 54 above shows how the date axis changes with the 
Vertical orientation option chosen.  

Resizing Plot Boundaries  
This menu selection brings out a dialog for entering new a width and height of the plot 
window. It opens with the current width and height in pixels and expects the new values 
in pixels to be entered. If an entered number is too small or too big, the out of range 
warning will appear that gives the range of possible values. The upper limit is pretty large 
and the width of the plot is going to be limited by the width of the screen. The plot also 
can be resized by dragging the sides or corners of the plot window. Refer to the XY Plot 
section for figures and more explanatory detail. 

Zoom in both axes  
This menu selection displays a part of the plot corresponding to a smaller range of values 
of both axes. The same effect can also be achieved by clicking in the plot area and 
“stretching” a rectangle from its left upper corner to the lower right corner for a new plot 
area.  

Zoom out both axes  
This operation reverses the previous action, it restores the display of the larger portions of 
each axes. The Zooming out effect can also be achieved by clicking in the plot area and 
moving the pointer right to left and upward. 

Zoom in x axis, Zoom in y axis  
The action displays a part of the plot corresponding to a smaller range of values of the 
corresponding axis.  

Zoom out x axis, Zoom out y axis  
The previous operation may be reversed with this option; it restores a previous range of 
values of the corresponding axis.  

Auto Scale  
These choices bring the display of the axes back to the full range of the values of the 
independent variable and the function.  

Help Menu 
The Help menu provides explanation for each of the menu options for the Date XY Plot. 
It may be accessed by using the menu bar or shortcut key combination Alt+h (Windows), 
or Control+Option+h (Macintosh). Under the Help menu, there are five submenu options 
corresponding to the four menus at the top of the graph frame.  
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Glossary of Terms 
DOE Department of Energy 

DTRIAC Defense Threat Reduction Information Analysis Center 

DVD Digital Video Disk 

Java™ A programming language and trademark of Oracle Corporation 

JRE Java Runtime Environment 

LANL Los Alamos National Laboratory 
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Distribution 
Distributed electronically with the LANL Nuclear Weapons Analysis Tools Software 


